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PVII Column Composer Magic (CCM) 
This user guide is intended to introduce you to the way Column Composer works and how to use 

the interface. In addition to this user guide, there is an online repository of highly focused Column 

Composer Magic deployment and customization tutorials, in both text and video formats. 

Online CCM Tutorials and Videos 

Install the extension 
Look for the extension installer file p7_CCM_251.mxp (or higher) in the root of the zip archive you 

downloaded. Double-click the file to install the extension. Dreamweaver's Extension Manager will 

open and you will be prompted to complete the installation. Once your installation is completed, 

restart Dreamweaver. 

OS X users: If, upon double-clicking the installer, Extension Manager does not properly launch, you have a 

file association issue. To remedy the problem locate the installer file from inside a Finder window and 

double-click it. 

  

http://www.projectseven.com/products/tools/composer/tutorials/
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Work in a defined Dreamweaver site  
Before you begin, make sure you are working inside a defined Dreamweaver web site. This is 

necessary so that Dreamweaver knows how to link required assets. If you are new to Dreamweaver 

or need to learn how to define a web site, follow these simple steps: 

Choose Site > New Site 

Specify local site location  
The Site category of the Site Setup dialog box is the only one you need to fill out to begin working 

on your Dreamweaver site. This category lets you specify the local folder where you’ll store all of 

your site files. When you’re ready, you can fill out the other categories in the Site Setup dialog 

box, including the Servers category, where you can specify a remote folder on your remote server.  

Site Name  

The name that appears in the Files panel and in the Manage Sites dialog box; it does not appear in 

the browser.  

Local Site Folder  

This is the name of the folder on your local disk where you store site files, templates, and library 

items. Create a folder on your hard disk or click the folder icon to browse to the folder. When 

Dreamweaver resolves site root-relative links, it does so relative to this folder. 
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Compose CSS Columns or Entire CSS Pages 
M A K I N G  C S S  C O L U M N S  A N D  P A G E S  H A S  N E V E R  B E E N  T H I S  E A S Y  

Column Composer Magic is a revolutionary Dreamweaver plug-in that enables you to compose 

CSS column structures, as well as entire CSS pages, from the comfort of a graphical user interface 

inside Dreamweaver. You can use CCM to add multi-column structures anywhere on your existing 

page or inside widgets, such as accordion or tab panels. You can also use CCM to create an entire 

CSS page layout. With CCM, you are in total control. 

 

CCM is based on rows. Each row you create can be set to various configurations of between 1 and 

5 columns. Rows can be added, deleted, or re-ordered. You can insert any type of content into 

your rows and columns, which are fully editable within Dreamweaver's design view. Nesting of 

structures is fully supported. 

The Column Composer Magic Interface 
Column Composer Magic has its own intuitive user interface—fully integrated inside 

Dreamweaver. The UI has a Create and a Modify mode that give you complete control over the 

creation and modification processes. 
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The Create and Modify UI Modes 
Based on your current insertion point in the page, the interface will open in Create mode or 

Modify mode. You can then create a new CCM structure or modify an existing one. If your cursor 

is inside of an existing CCM structure, you will get a special dialog box asking you if you'd like to 

modify the existing structure or create a nested one. 

A Column Composer Structure is comprised of the rows and columns you define in the CCM interface. 

Create mode 
If your insertion point is not within an existing Column Composer Magic structure, the user 

interface will open in Create mode. 

Modify mode 
If your insertion point is inside an existing Column Composer Magic structure, a dialog box will 

open allowing you to choose whether to Modify the existing structure or Create a Nested One. 

This allows you to easily add new Column Composer Magic structures into the columns of existing 

Column Composer Magic structures—a process called nesting. 

CCM Features 
CCM comes with many useful options and features that can be used to customize the look and 

feel of your rows and columns. 

Creating a New CCM structure 
Column Composer Magic structures can be inserted anywhere on your page. They can even be 

nested inside an existing Column Composer Magic column or the content panel of a PVII widget. 

You can insert as many individual Column Composer Magic structures as you like on your page. 

Each one can be configured independently to set different options and features. Different 

structures on a single page can share the same style theme or be set to separate style themes. 

Each structure can contain any type of content. Column content is directly editable in 

Dreamweaver Design View using normal Dreamweaver editing techniques. 
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The Creation process 

 Establish the insertion point for your new Column Composer Magic structure by clicking in the 

area of the page where you would like the structure to be created.  

 Click the Column Composer Magic icon      in the PVII Section of Dreamweaver's Insert Bar/Panel or 

choose  

Insert > Studio VII > Column Composer Magic by PVII. 

The Column Composer Magic user interface will open in the Create New Column Composer Magic 

Structure mode.  
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Add as many rows as you like, set your column layouts and options, and then click OK to build the 

structure at your insertion point. We'll discuss each of the interface options, in detail, in the 

Modifying an Existing Structure section below. 

You can create as many Column Composer Magic structures as you like on a given page.  

Tip: When you insert a Column Composer Magic structure, some of the more advanced CSS styles, such as 

shadows, rounded corners, and equal height columns will not be reflected in Dreamweaver Design View. 

Dreamweaver simply does not support some modern CSS standards. Column Composer Magic styling and 

functionality can be accurately tested by previewing in your browser. 

Asset Folders 
When you create a structure, the system creates an assets folder named p7CCM at the same level 

as the page that contains your structure. This folder will contain the relevant CSS files. To work 

around Dreamweaver's inability to render some of the modern CSS techniques used, the system 

will automatically create a Design Time (DT) style sheet that will allow Dreamweaver to render the 

structure as accurately as possible.  

 

If you have enabled the Equal Height Column option the system will also create an asset folder 

named p7ehc at the same level as the page that contains your structure. This folder will contain 

the Equal Height Column JavaScript file. 

The system will also create a p7ie_fixes folder at the root-level of your site so that we can safely 

link to an external CSS file within a conditional comment and not have to worry that Dreamweaver 

will not be able to adjust its path. 

 

When you publish your site, make sure you upload the entire p7CCM, p7ehc, and p7ie_fixes 

folders.  
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Modifying an Existing structure 
You can modify any of the existing CCM structures on your page at any time. 

The Modify process 

 Click inside the Column Composer Magic structure that you wish to modify. 

 Click the Column Composer Magic icon       in the PVII Section of Dreamweaver's Insert Bar or 

Insert Panel—or choose 

Modify > Studio VII > Modify Column Composer Magic by PVII 

 

Note: If you use a Macintosh computer, Apple bugs will sometimes cause the Modify menu to be inactive 

(grayed out). If this happens to you, use the icon to launch the interface. You can also launch the interface 

from the Insert menu. The system will open the interface in the appropriate mode. If you would like to fix 

this Apple bug, download and install this Command and then restart Dreamweaver. 

Select Action Dialog 
This dialog box will allow you to make a choice to either modify the existing CCM structure or 

nest a new CCM structure inside the existing one.  

 

Note: This dialog only appears when your insertion point is inside an existing CCM structure. If your 

insertion point is not inside a CCM structure, the main interface will open directly in Create mode. 

http://www.projectseven.com/go/returnfalsefix
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The CCM User Interface will open in the Modify Existing Column Composer Structure mode. 

 

Note: The selected CCM structure will also be highlighted in Dreamweaver Design View and in Code View. 

The highlighting will help serve as a visual clue to the actual CCM structure you are Modifying, which could 

be especially helpful when working with nested structures. 

Configure your rows and options and click OK. 
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Managing the User Interface Items 

Mode 

Displays the current operational Mode for the user interface—either Create or Modify. When in 

Modify mode, the id of the Column Composer Magic structure being modified will also be 

displayed. 

Outer Style Options 
These options are applied to the outer container of the CCM structure. The styling of these 

options will be based on the Style Theme you have chosen.  

Note: If you have chosen The Un-Style theme, none of the outer styling options will apply. 

Outer Border 

This applies a border around the outside of the CCM structure. 

Rounded Outer Corners 

This will apply rounded corners to the outside of the CCM structure. 

Outer Shadow 

This will apply a shadow to the outside of the CCM structure. 

Width 

The CCM system allows you to choose from a variety of width options for your structure: 
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Auto -The CCM structure will have no width assigned and will adapt to the entire available width 

of the browser window or that of any containing element to which a width has been assigned. In 

most cases, when nesting a CCM structure inside another CCM structure, you should choose Auto. 

MinMax - Choose this option when using the CCM system to create a page framework. The 

structure will be flexible with minimum and maximum width settings. This allows the structure 

from getting too wide on large monitors and prevents it from getting too narrow in smaller 

browser windows. In most cases, you should not use MinMax widths when nesting CCM 

structures. 

Fixed - Choose one of the fixed widths. 

Rows  
This box displays a line for each row in the CCM structure. The text represents the Column Layout 

option chosen for that row. You can add, delete or move rows at any time. Select the line you wish 

to act on and use the row management buttons above the Row listing. 

Row Management Buttons 

Add: Use this button to add a row. A new line will be created with the default "1 Column" layout 

option. The new line will be created immediately after the currently selected line. 

Delete: Use this button to remove the currently selected row. The row and its contents will be 

removed. 

Up: This button will move the selected line in the Rows list up one line. Successive clicks will keep 

moving the row up, one line per click, until it reaches the top of the list.  

Down: This button will move the selected line in the Rows list down one line. Successive clicks will 

keep moving it down, one line per click, until it reaches the bottom.  

Row Options 
Row options are set independently for each row that you add to the structure.  
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Column Layout 

Each row can have a different column configuration. Choose from the list of preset configurations: 

 

Row Borders 

Each new row is initially set to display with neither top nor bottom borders. To provide a 

separation line between rows enable top, bottom or top and bottom borders. 

Row Background 

Each row can be assigned a background color:  

 Normal - The default row background color for the selected Style Theme. 

 Contrast -This is the contrasting color for the selected Style Theme, this is normally used for 

header and footer rows. 

 Accent -This is the background color intended for data or information boxes within a layout. 

 None -Choose this option if you do not want a background color, the row will be transparent. 

 

Tip: The actual colors for these choices depend on the style theme being used and are illustrated in the Style 

Theme preview image. 

Column Separators 

Enable this option to show borders between the columns in the selected row.  

Enable Equal Height Columns 

Check this option to have the system use the Equal Height Columns script to assure that all 

columns in the row will be of equal height, regardless of the amount of content in each column. 
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Row Inner Shadows 

Enable this option to show a shadow around the interior of the entire row. 

Content Inner Shadows 

Enable this option to show a shadow around the interior of each column in the row. 

Auto Size Images 

This option sets any image placed inside a column in the selected row to dynamically resize based 

on the width of the column, assuring that your images will always fit—even when your layout is 

set to a flexible width. 

Content Padding 

By default, each column's interior is assigned padding, which creates a visually pleasing sense of 

space around normal content. If you would prefer that a particular row's columns should be free 

of any white-space you can Uncheck (disable) this option. 

Use RGBA Background Color 

Each Style Theme includes an RGBA background color option. The RGBA color syntax allows for 

opacity as part of the style rule and provides a pleasing semi-transparent look for the background 

color.  

Note: Dreamweaver Design View cannot render the RGBA colors and will show the normal background color. 

The RGBA background color will render perfectly in all modern browsers. IE8 and under will show the normal 

background color. 

Preserve Content on Column Layout Changes 

When changing an existing row's Column Layout to a smaller number of columns, the content that 

was in a deleted column will be orphaned. With this option turned on the system will automatically 

move any orphaned content into the last remaining column to assure that no custom page content 

is ever lost. 

This option is automatically turned on whenever the system is in Modify mode and automatically 

turned off when in Create mode. 

  



15 The Column Composer Magic Interface 

 

© 2011-2013 Project Seven Development. All Rights Reserved. 

 
15 

Style Theme 
Column Composer Magic comes with a variety of pre-defined CSS style themes. Choose a theme 

that best approximates the look you desire. You can later make edits to the style sheet to fully 

customize the look. You can change to a different style theme at any time without affecting your 

content or settings.  

 

A preview of the selected Style Theme is displayed to the right of the Style Theme select list. This 

Preview will change whenever you select a different Style Theme. 
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Command Buttons 
The following command buttons are available. 

In Create Mode In Modify Mode 

 

 

OK: When you are done, click the OK button to build the structure.  

Remove: Available in Modify mode only. Click to remove the current CCM structure from your 

page, along with any assets that are no longer needed. 

Note: All actions and changes to the page made by the CCM system are also available in the Dreamweaver 

Undo memory. If you accidentally remove content that you did not intend, you can restore the actions by 

choosing Edit-Undo from the main Dreamweaver menu. 

Cancel 

Click the Cancel button to completely abort the current operation. This will close the interface and 

no changes will be made to your page. 

Help 

Click the Help button to open the associated Help File in your browser. This page can remain open 

for easy reference while you continue working with the Column Composer Magic interface. 
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Using Column Composer Magic 
If you're like us, you've already jumped in and created some structures and are ready to learn how 

to use all of the features to their utmost capabilities. But before you do, there are a couple of 

points that bear covering: 

Make sure your structure will fit 
If you choose a fixed width, make sure that it will fit. If your layout is flexible, you should make 

sure you have set a min-width in the CSS rule for your body. Min-width allows a layout to contract 

to a specified width, at which point the browser will spawn horizontal scrollbars. The value you set 

should be based on the point at which your layout contracts sufficiently to make reading the 

content difficult or impossible. Look for the body rule in the CSS file that is used for your general 

page layout, not in the CCM style sheet. If one does not exist, create one using this syntax: 

body { min-width: 800px; } 

Insertion points 
Click where you want the structure to go. If you click in the middle of a paragraph, for example, 

the structure will split the paragraph—ending the original paragraph before the structure and 

creating a new paragraph below. If the structure does not go precisely where you wanted it to go, 

simply choose Edit > Undo and try again.  

  



18 Using Column Composer Magic 

 

© 2011-2013 Project Seven Development. All Rights Reserved. 

 
18 

Creating adjacent structures 
There will be times when, instead of nesting one structure inside another, you might need to 

insert a new CCM structure below an existing one.  To do this, place your cursor inside the 

existing structure and open the CCM interface. The Select Action dialog will open: 

 

Choose the third option: 

Create Adjacent Column Composer Magic 

The main interface will open and the structure you create will be inserted below the selected one. 
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Inserting CCM in existing pages and widgets 
If you need to insert a multi-column structure in your page, CCM can save you the time and hassle 

of coding it yourself. Simply open your page, click where you want to insert your structure, open 

the CCM interface, and compose your structure. When inserting into existing pages, it is 

recommended that you choose the Auto width option. That way, your structure will conform to the 

width of your existing page.  

This is a 2-column CCM structure inserted into the main column of one of our CSS Templates 

(Page Builder Magic): 

 

This is a 3-column structure inserted into a Tab Panel Magic 2 content panel: 

 

http://www.projectseven.com/products/tools/tpm2/
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Creating entire pages with CCM 
Once you use Column Composer to create a web page, you'll wonder how you ever lived without 

it. Here's what you do: 

Create a blank page and save it in your defined Dreamweaver site. Now, let's say you want a page 

with the following characteristics: 

1. Flexible width with minimum and maximum width constraints 

2. A banner 

3. A horizontal menu below the banner 

4. A 3-column main content area with fixed-width sidebars 

5. A footer 

Open the CCM interface and create your structure with 4 rows: 

 

The first row is your single-column banner. The second row is where your menu goes, the third 

row is for your main content and sidebars, and the last column is your footer. Set any additional 

options you desire and a style theme, and click OK. 

  



21 Nesting CCM Structures 

 

© 2011-2013 Project Seven Development. All Rights Reserved. 

 
21 

If you selected Style Theme 1 and set the top row to have a contrasting color, the bottom row to 

have an accent color, and assigned top and bottom borders, you would wind up with a page that 

looked something like this: 

 

Your investment in time would be perhaps half a minute. 

Nesting CCM Structures 
Column Composer Magic has full support for nesting. Nesting makes sense when your design 

calls for more than simply adding another row to your base structure. For instance, you would 

nest if you wanted a structure inside of the center column of the third row in this layout: 

 

To do that, place your cursor inside the center column where you want the new structure to be. 

Open the CCM interface, which would detect that your insertion point is inside an existing 

structure and present you with the following dialog: 
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Click the Create Nested Column Composer Magic button and the main interface will open: 

 

Set your options and click OK to build and insert your nested structure. Notice in the UI capture 

above, we've turned off all of the Outer Style Options to give us a clean structure that will blend 

into the main content column of our layout. You would wind up with a structure that looked like 

this: 
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If you want a highly stylized box for your nested structure, you can set some or all of the Outer 

Style Options and even an accent color: 

 

Online Tutorials and Videos 
Please visit the online repository of Column Composer Magic text-based and video-based 

tutorials that focus on specific tasks and processes: 

Online CCM Tutorials and Videos 

  

http://www.projectseven.com/products/tools/composer/tutorials/
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Design Aids 
When you create a CCM structure, you will see it outlined with a colored dashed outline in 

Dreamweaver Design View. Each structure will receive a separate outline. This will help you 

identify root and nested structures when you want to edit them.  
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When you open the interface to edit a particular structure, it will be highlighted in dark blue. If 

your structure has multiple rows, as you highlight a row in the CCM interface the actual row on 

your page will also highlight. 

 

 

 

If you delete or move a row in the CCM interface, the row highlighting will not reflect this until you 

click OK and then reopen the interface. 

Saving Copies of Pages Causes Loss of Styling 
If you save a copy of a page that contains a CCM structure, using File > Save As, the CCM 

structure on the new page will look unstyled. This is because of Dreamweaver’s relatively poor 

native CSS support (up to version CS5.5). To enable the CCM Design Time style sheet that fixes 

Dreamweaver Design View, select one of your CCM structures on that page and open the interface, 

as if you were going to edit it. Simply click OK and Dreamweaver’s Design View workarounds will 

kick in. 
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CCM Style Themes 
Column Composer Magic ships with 5 style themes: 

01- Classic 

 

p7ccm01.css 

02 - Carbon 

 

p7ccm02.css 

03 - The News 

 

p7ccm03.css 

04 - The Un-Style 

 

p7ccm04.css 

05 - Artisan 

 

p7ccm05.css 

  

  

Themes are assigned per structure. Nested structures can be set to different themes than their 

parent structures. Each theme comes with its own CSS file as noted in the chart above. Like most 

CSS frameworks, Column Composer CSS files are core CSS files—and seldom need to be edited. 

One of the more powerful features of Column Composer Magic is that it is programmed to 

support user-assigned classes and IDs  

To learn more about customizing CCM please visit the online tutorials and videos page: 

Online CCM Tutorials and Videos 

  

http://www.projectseven.com/products/tools/composer/tutorials/
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Getting help 
PVII quality does not end with your purchase - it continues with the best customer support in the 

business. 

PVII Knowledge Base  

The PVII Knowledge Base is an online PVII application allowing you to access dozens of Tech 

Notes, tips, and techniques relating to our products, as well as to general web development 

issues. 

Open the Knowledge Base | View the 10 Most Recent Additions 

PVII Communities 
PVII maintains separate and distinct Web Forum and Newsgroup communities. We do this to 

ensure you always have access via your preferred medium and device. 

1. The PVII Web Forums 
The PVII Web Forum is a modern browser-based community, accessible to both desktop and 

mobile devices and requires no additional software or plugins. 

Visit The PVII Web Forum community now... 

  

http://www.projectseven.com/support/questions.asp?
http://www.projectseven.com/support/questions.asp?type=recent
http://www.pviiforums.com/


28 Getting help 

 

© 2011-2013 Project Seven Development. All Rights Reserved. 

 
28 

2. PVII Newsgroup forums 
The Project VII Newsgroup is available via private and secure NNTP servers. In order to subscribe 

to a newsgroup you must have a newsgroup-capable client installed such as: 

1. Mozilla Thunderbird 

2. Windows Live Mail 

3. Windows Mail/Outlook Express 

4. Opera Mail 

5. Entourage 

Server: forums.projectseven.com 

Need help setting up a newsgroup?  

Setting up a new newsgroup account in Windows Mail (Vista) 

Setting up a new newsgroup account in Outlook Express 

Setting up a new newsgroup account in Mozilla Thunderbird  

Setting up a new newsgroup account in Entourage  

If you have another newsgroup-capable program that you are using, please see its documentation 

to learn how to add a new newsgroup account. 

Note: PVII newsgroups are private and have nothing to do with Usenet feeds that may be provided by your 

ISP. That is, you will not find our newsgroups in a list of newsgroups distributed by your internet service 

provider. You must set up our news server as a new account. 

RSS News Feeds 
Keep up with the latest news the minute it's released by subscribing to our RSS news feed. If you 

are not sure how to subscribe, please check this page: 

PVII RSS Info 

  

http://www.projectseven.com/support/winmail.htm
http://www.projectseven.com/support/oe.htm
http://www.projectseven.com/support/tbird.htm
http://www.projectseven.com/support/entourage.htm
http://www.projectseven.com/xml/index.htm
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Before you Contact us 
Before making a support inquiry, please be certain to have read the documentation that came with 

your product. Please include your Dreamweaver version, as well as your computer operating 

system type in all support correspondence. 

E-Mail: 

support@projectseven.com 

Phones:  

330-650-3675 

336-374-4611 

Phone hours are 9:00am - 5:00pm Eastern Time U.S. 

Snail mail 
Project Seven Development 

339 Cristi Lane  

Dobson, NC 27017 

  

  

mailto:support@projectseven.com
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